Abstract

This article introduces the \texttt{gsemthesis} class for \LaTeX. The \texttt{gsemthesis} class is a PhD thesis template for the Geneva School of Economics and Management (GSEM), University of Geneva, Switzerland. The class provides utilities to easily set up the cover page, the front matter pages, the pages headers, etc. with respect to the official guidelines of the GSEM Faculty for writing PhD dissertations. This class is released under the LaTeX Project Public License version 1.3c.

*This document corresponds to \texttt{gsemthesis} v0.9.4, dated 2015/02/09.
### Contents

1 Introduction 3

2 Usage 3
   2.1 Requirements ................................................................. 3
   2.2 Getting started ............................................................... 3
   2.3 Configuring your editor to store files in UTF-8 ....................... 4
   2.4 Writing the dissertation in French ..................................... 4
   2.5 Configuring and printing the cover page ................................. 4
   2.6 Configuring and printing the front matter pages ....................... 4
   2.7 Introduction and conclusion ............................................ 5
   2.8 Bibliography ........................................................................ 5
      2.8.1 Configure TeXstudio to run biber .................................. 5
      2.8.2 Configure Texmaker to run biber .................................. 5
      2.8.3 Configure Rstudio/knitr to run biber ............................... 5
      2.8.4 Basic commands ........................................................... 6
      2.8.5 Using your own bibliography management configuration ....... 6
   2.9 Draft mode ......................................................................... 6
   2.10 Miscellaneous ................................................................. 6

3 Minimal working example 7

4 Implementation 8
   4.1 Document properties .......................................................... 8
   4.2 Colors ............................................................................... 8
   4.3 Graphics ............................................................................ 8
   4.4 Link management ............................................................... 9
   4.5 Maths ................................................................................. 9
   4.6 Page headers management .................................................... 9
   4.7 Bibliography management .................................................... 10
   4.8 Cover page .......................................................................... 11
      4.8.1 System-level functions ................................................ 11
      4.8.2 User-level functions ..................................................... 12
   4.9 Front matter ....................................................................... 15
   4.10 Introduction and conclusion starter ...................................... 16
   4.11 Miscellaneous .................................................................... 17
1 Introduction

PhD thesis published within the Geneva School of Economics and Management have to follow some guidelines, especially for the cover page. The \texttt{gsemthesis} class is a \LaTeX\ template providing utilities to easily set up these guidelines in your thesis. In addition the class loads several useful packages generally used when writing a thesis. We recommend the user to have a look to the class definition in Section 4.1 to be aware of the list of packages that the class already includes. The Section 2 details how to start with the \texttt{gsemthesis} class and how to configure your thesis. The Section 3 provides a minimal working example you can copy/paste for starting your dissertation. The user interested in customizing the class can read the Section 4 which details the full implementation of the class with useful comments.

This class was successfully tested with TeX Live 2013/Debian, TeX Live 2014/CentOS;Windows7 and MiKTeX-2.9.5105/Windows7.

This class has been written by Emmanuel Rousseaux with contributions from William Aeberhard and Tuan Nguyen.

The development version is hosted on GitHub\footnote{https://github.com/emmanuelrousseaux/gsemthesis}. If you are interested in contributing to this class or if you want to beta test latest versions, please visit the repository.

2 Usage

This Section introduces the use of the \texttt{gsemthesis} class. All macros and environments the class provides are described. We assume the user is already familiar with \LaTeX.

2.1 Requirements

The class requires a recent version of either TeX Live ($\geq$ 2014 recommended, $\geq$ 2013 minimal) or MiKTeX ($\geq$ 2.9.5x minimal). As the class preload some common packages (see Section 4 for the detailed list), we suggest to use install your \LaTeX\ distribution in full mode to make things working out-of-the-box.

The class uses biblatex/biber for managing the bibliography. Please refer to the Section 2.8 for configuring your editor to use it.

2.2 Getting started

To use the class start your document with the command \texttt{\documentclass[gsemthesis]}. A minimal document is:

\begin{verbatim}
\documentclass[gsemthesis]
\begin{document}
\printcoverpage
\newpage
Here is it, I started my PhD!
\end{document}
\end{verbatim}

The Section 3 provides a minimal working example you can copy/paste for starting your dissertation. Commands available for configuring your thesis are explained in the following sections.
2.3 Configuring your editor to store files in UTF-8

The class assumes that all your .tex and .bib files are encoded in UTF-8. The UTF-8 encoding is a dominant character encoding available on all recent systems and used by default by a lot of editors. As a consequence, it limits encoding problems when sharing files from different systems (Windows, MacOS, Unix/Linux, web sites, etc.). If some of your source files are stored with a different encoding, you may experience rendering problems with accentued/foreign characters. These characters can occur, for instance, in author names of the bibliography. For making sure you won’t experience rendering problems, consider (1) storing your files in UTF-8 and (2) set UTF-8 as the default encoding of your editor. Any recent text editor is able to convert files to UTF-8. TeXstudio and TeXmaker seem to used UTF-8 by default. Rstudio seems to use the system default encoding. To change this setting go to File > Save with encoding. On NotePad++ go to Encoding > Convert to UTF-8.

2.4 Writing the dissertation in French

The GSEM accepts English and French for PhD thesis dissertations. Default language is English. If you write your dissertation in French, you have to you the fr class option as follows:

\documentclass[fr]{gsemthesis}

2.5 Configuring and printing the cover page

The class provides the GSEM PhD thesis cover page ready to be printed. You can ask to print it by calling \printcoverpage just after the \begin{document}. Before printing the cover page you first need to configure it with your thesis details: title, author, supervisors, committee, etc.

The class uses the classical \title{text} and \date{text} commands of the book class to set the title and the date. Instead of using the \author{text} command we provide the two commands \authorFirstname{text} and \authorLastname{text} to separately handle the firstname and the lastname. You specify the PhD you are enrolled in with the \thesisField{text}, among others: Economics, Management, Statistics, Information Systems. Please contact the scientific committee of your PhD to obtain the applicable title. You can specify information about members of your thesis committee with the six \thesisCommitteeA-F{title}{firstname}{lastname}{role} commands. With the role field you specify the role played by this member in the committee and his/her affiliation. Generally you specify the role “Chair” in \thesisCommitteeA, the role “adviser” for your adviser/co-advisers, and leave the field empty for the other members. When your manuscript has been accepted by your jury, the Faculty attributes a unique thesis number which has to be printed on the cover page. The \thesisNumber{text} allows to supply it.

2.6 Configuring and printing the front matter pages

After the cover page the thesis has to provide in a the following order (1) the acknowledgements, (2,3) an abstract in both English and French (the order depending on the main language of your dissertation: if your dissertation is written in English you will start with the English abstract; if your dissertation is written in French you will start with the French abstract), (4) the table of contents, and (5) an optional dedication. These elements are usually called the front matter. These pages will be printed by calling the \printfrontmatter command. The best place for this command is just after the \printcoverpage command. To fill these pages use the commands \acknowledgements{text}, \abstractEN{text}, \abstractFR{text}, and
\textbf{Introduction and conclusion}

Generally we don’t want to number the introduction and the conclusion, but we want they appear in the table of contents. This leads to a specific handling of the creation of these chapter, especially to have correct page headers. Therefore, instead of using \chapter{introduction} (respectively \chapter{conclusion}) to start a such chapter we provide the function \startintroduction (respectively \startconclusion) to easily start the chapter with a correct handling of the table of contents and page headers.

\textbf{Bibliography}

To produce the bibliography, the \texttt{gsymthesis} class uses the package \texttt{biblatex} with \texttt{biber} in backend instead of the package \texttt{bibtex}. The package \texttt{biblatex} is installed by default with any recent version of TeX Live\footnote{On Ubuntu/Debian, you may have to install it manually: sudo apt-get install texlive-bibtex-extra biber} (full installation) and MiKTeX, but you must first configure your TeX Editor to use it.

\subsection*{Configure TeXstudio to run biber}

In the TeXstudio preferences (click on Options \rightarrow Configure TeXstudio), choose the ‘Build’ tab and modify the ‘Default Bibliography’ to ‘Biber’.

Run ‘Build & View’ from the ‘Tools’ menu (or press the two green arrows icon), which will create a PDF but with the bibliography not completed.

Run ‘Bibliography’ from the ‘Tools’ menu.

Run ‘Build & View’ again to create a PDF with the bibliography.

\subsection*{Configure Texmaker to run biber}

In the Texmaker preferences (click on Options \rightarrow Configure Texmaker), choose the ‘Commands’ tab and replace \texttt{bibtex} \% by \texttt{biber} \% in the field \texttt{Bib(la)tex}. On Windows, you may also browse to the \texttt{biber.exe} using the folder icon on the side.

Choose the ‘Quick Build’ tab and select the second option \texttt{PdfLaTeX + Bib(1a)tex + PdfLaTex (x2) + View Pdf}

Now your ‘Quick Build’ button will create a PDF with the bibliography.

\subsection*{Configure Rstudio/knitr to run biber}

In Rstudio/knitr you have to include the following chunk in your \texttt{.Rnw} document:

\begin{verbatim}
<<tex-setup, include=FALSE, cache=FALSE, echo=FALSE>>=
Sys.setenv(
    TEXINPUTS=getwd(),
    BIBINPUTS=getwd(),
    BSTINPUTS=getwd()
)
@
\end{verbatim}
2.8.4 Basic commands

To add a bibliography into your document, you have to define your bib file in the preamble of your tex file: `\addbibresource{literature-review-topic1.bib}` Then, at the end of your document, the command `\printbibliography` will create the bibliography.

2.8.5 Using you own bibliography management configuration

If you prefer not to use the bibliography management configuration we implemented in this class, you can disabled it and writing you own. Disabling the `gsemthesis` bibliography management configuration is easily done with the `custombib` class option:

```
\documentclass[custombib]{gsemthesis}
```

When using this option you will have to provide the package you want to use for managing your bibliography (natbib, chapterbib, etc.). As the option disables all settings you will also need to load the package `biblatex` if you want to use it.

2.9 Draft mode

When sharing draft versions of your dissertation you may prefer to hide some items of the cover page (thesis committee, thesis number, etc.) and some Sections (acknowledgments, the dedications, etc.) that probably have not been defined yet. For this purpose you can use the `draft` option:

```
\documentclass[draft]{gsemthesis}
```

Note: this draft mode extends the classical \LaTeX draft mode and then all packages supporting a draft mode will also switch to the draft mode\(^3\). For convenience purposes we forced packages `graphicx` and `hyperref` to be in `final` mode even when draft mode is on.

2.10 Miscellaneous

The class also provides some optional functions that can turn out to be usefull when writing your thesis. The default `itemize` environment set important spaces between each items, the previous paragraph and the next paragraph. The `itemize*` environment reduces these spaces to allow a more compact (and nicer) presentation of a list item. 

Forthcoming. To add: section in redaction, todonotes

---

\(^3\)Common packages supporting a draft mode are: `changes` (final disables markup of changes, and list of changes), `graphicx` (draw frames instead of including images), `hyperref` (disable all linking features), `listings` (don’t include external files), `listofsymbols` (final suppresses printing of macro names and unused symbols), `mfic` (assume every latex run to be the first one), `microtype` (disable all features), `pdfcomment` (final suppresses the comments), `pdfpages` (don’t include external file but print a frame box), `pgf` (similar to graphics/x: all images will be replaced by empty rectangles), `showkeys` (draft shows the labels, the default option), `thumbs` (thumbs’ width=2pt, thumbs’ text=black, thumbs’ color=grey), `varioref` (turn warnings in error messages). Source: [http://tex.stackexchange.com/questions/49277/what-does-the-draft-mode-change/49278](http://tex.stackexchange.com/questions/49277/what-does-the-draft-mode-change/49278)
3 Minimal working example

\documentclass{gsemthesis}
\title{An innovative approach to deal with a very important issue}
\date{\today}
\author{Firstname Lastname}
\author{Firstname Lastname}
\thesisField{Econometrics}
\thesisCommitteeA{Prof.}{Mike}{Moore}{Adviser, University of Geneva}
\thesisCommitteeB{Prof.}{Mike}{Moore}{Chair, University of Honolulu}
\thesisCommitteeC{Prof.}{Mike}{Moore}{University of Omsk}
\thesisCommitteeD{Dr.}{Mike}{Moore}{Eidgenössische Technische Hochschule Zürich}
\thesisNumber{480}
\acknowledgements{Your acknowledgements}
\abstractEN{English version of the abstract}
\abstractFR{French version of the abstract}
\dedication{To my family.}
\addbibresource{literature-review-topic1.bib}
\addbibresource{literature-review-topic2.bib}
\begin{document}
\printcoverpage
\printfrontmatter
% INTRODUCTION
\startintroduction
Write your introduction here.

% CHAPTER
\chapter{A first chapter}
\label{ch:chapterone}
My chapter 1.

% CONCLUSION
\startconclusion
The conclusion.

% BACKMATTER
\listoftables
\listoffigures
% Bibliography (at the end)
\newpage
\printbibliography
\end{document}
4 Implementation

In this Section the full code of the \texttt{gsenthesis} is discussed. The reader interested in customizing the class will find useful comments to understand the design of the class.

4.1 Document properties

The class is derived from the standard \texttt{book} class as follows:

\begin{verbatim}
\LoadClass[a4paper,12pt,twoside]{book}
\end{verbatim}

We set the document encoding to UTF-8

\begin{verbatim}
\usepackage[utf8]{inputenc}
\end{verbatim}

We use the \texttt{lmodern} vectorial fonts to render the document.

\begin{verbatim}
\usepackage{lmodern}
\end{verbatim}

We use the \texttt{etoolbox} package for defining class options (fr, draft)

\begin{verbatim}
\usepackage{etoolbox}
\end{verbatim}

We add the option \texttt{fr}

\begin{verbatim}
\newtoggle{fr}
\DeclareOption{fr}{\toggletrue{fr}}
\end{verbatim}

We add the option \texttt{draft}

\begin{verbatim}
\newtoggle{draft}
\DeclareOption{draft}{\toggletrue{draft}}
\end{verbatim}

We add the option \texttt{custombib}

\begin{verbatim}
\newtoggle{custombib}
\DeclareOption{custombib}{\toggletrue{custombib}}
\end{verbatim}

The recommended page format is A4. The B5 page format is given in option.

\begin{verbatim}
\DeclareOption{b5paper}{
\PassOptionsToClass{\CurrentOption}{book}
}
\ProcessOptions
\end{verbatim}

We use the \texttt{geometry} package to set margin properties

\begin{verbatim}
\RequirePackage[top=2.5cm, bottom=2.5cm, left=2.5cm, right=2.5cm]{geometry}
\end{verbatim}

We use the package to handle some specific text spacing (title)

\begin{verbatim}
\usepackage{setspace}
\end{verbatim}

4.2 Colors

We define some nice colors that will be later used for links (url, email, citations, etc.). The \texttt{gsemblue} color is the official color (to date 2014.02.20) of the GSEM Faculty.

\begin{verbatim}
\usepackage{xcolor}
\definecolor{erblue}{HTML}{126199}
\definecolor{erorange}{HTML}{FF7F00}
\definecolor{gsemblue}{HTML}{465F7F}
\end{verbatim}

4.3 Graphics

We add some practical packages to handle several image files (.png, .pdf), handle placement of graphics, and handle subfigures

\begin{verbatim}
\usepackage{graphicx}
\usepackage{float}
\usepackage{subfigure}
\end{verbatim}
4.4 Link management

We use the \texttt{hyperref} package to manage internal links and set colors for each link type.

\begin{verbatim}
24 \RequirePackage{hyperref}
% \hypersetup{
26 % colorlinks=true, %
27 % linkcolor=black, %
28 % filecolor=greenblue, %
29 % citecolor=greenblue, %
30 % urlcolor=greenblue %
31 % }
32 \hypersetup{
33 colorlinks=true,
34 linkcolor=black,
35 filecolor=erblue,
36 citecolor=erblue,
37 urlcolor=erblue,
38 final
39 }
\end{verbatim}

We use the \texttt{url} package for a complete support of external links and define a nice font style.

\begin{verbatim}
40 \RequirePackage{url}
41 \urlstyle{sf}
\end{verbatim}

4.5 Maths

We add standard packages from the American Mathematical Society to handle mathematical symbols, environment (equations, etc.) and the Computer Modern font use by default to render math.

\begin{verbatim}
42 \usepackage{amssymb,amsmath,amsfonts}
\end{verbatim}

4.6 Page headers management

We use the \texttt{fancyhdr} package for a fine tuning of headers and footers of the different page type (cover page, chapters, unnumbered chapters, etc.).

\begin{verbatim}
43 \usepackage{fancyhdr}
\end{verbatim}

The capital letters given in option of \texttt{\textbackslash fancyhead} or \texttt{\textbackslash fancyfoot} commands respectively stands for:

- E: Even page
- O: Odd page
- L: Left field
- C: Center field
- R: Right field
- H: Header
- F: Footer

We set the \texttt{fancy} page style (default page style) as follows:

\begin{verbatim}
44 \pagestyle{fancy}
45 \fancyhf{}
46 \fancyhead[LE]{\thepage}
47 \fancyhead[RE]{\nouppercase{\leftmark}}
48 \fancyhead[LO]{\nouppercase{\rightmark}}
49 \fancyhead[RO]{\thepage}
50 \fancyfoot[LE,RO]{}
\end{verbatim}
We reset the plain style
\fancypagestyle{plain}{
  \fancyhf{}
  \renewcommand{\headrulewidth}{0pt}
  \fancyfoot[LE,RO]{}
}

We define a style for the cover page (actually not used)
\fancypagestyle{cover}{
  \fancyhf{}
  \renewcommand{\headrulewidth}{0.5pt}
  \renewcommand{\footrulewidth}{0.5pt}
}

We define a style for unnumbered chapters (starred chapters)
\fancypagestyle{unnumberedchapter}{
  \fancyhf{}
  \renewcommand{\headrulewidth}{0pt}
  \renewcommand{\footrulewidth}{0pt}
  \fancyhead[LE]{\thepage}
  \fancyhead[RE]{}
  \fancyhead[LO]{}
  \fancyhead[RO]{\thepage}
  \fancyfoot[LE,RO]{}
}

When a new chapter starts on a odd number, we add a blank page to force it to start to an even number. We define an empty style for this blank page
\fancypagestyle{empty}{
  \fancyhf{}
  \renewcommand{\headrulewidth}{0pt}
  \fancyfoot[LE,RO]{}
}

Then we apply the empty style to odd page before a new chapter
\def\cleardoublepage{\clearpage\if@twoside \ifodd\c@page\else
  \hbox{}
  \thispagestyle{empty}
  \newpage
  \if@twocolumn\hbox{}\newpage\fi\fi}
\clearpage{\pagestyle{empty}\cleardoublepage}

We define the default language of the document.
\iftoggle{fr}{
  \usepackage[francais]{babel}
  \usepackage[T1]{fontenc}
}{
  \usepackage[english]{babel}
}

This package provides the commands \og and \fg for correctly handling French quotes.
\usepackage{csquotes}

We define the date format for the cover page (non-draft mode).
\usepackage{datetime}
\newdateformat{monthyeardate}{\monthname[\THEMONTH] \THEYEAR}

4.7 Bibliography management

We use biblatex/biber to process the bibliography with the following settings: (1) citations with more than two authors will always be written as “First author et al.”, (2) this “et
al." rule is applied even if it leads to ambiguities between long list of authors with the same first author.

We use the style authoryear to print authors and the year when citing a document in the text. We define a customized sorting style to sort the list of references (printed at the end of the document) according to this (ordered) attributes: name, year, month, day, and title. We define the following sorting scheme:

4.8 Cover page

4.8.1 System-level functions

The following commands define labels for the different parts of the cover page
4.8.2 User-level functions

Set up of the cover page and assimilated functions.

\authorFirstname Set up the \authorFirstname variable.
\authorLastname Set up the \authorLastname variable.
\thesisField Set up the \thesisField variable.
\thesisCommitteeA Set up the \thesisCommitteeA variable.
\thesisCommitteeB Set up the \thesisCommitteeB variable.
\begin{verbatim}
184 \def\thesisCommitteeB{}
185 \newcommand{\thesisCommitteeB}[4]{{% 
186 \ifx&#3&% 
187  \def\thesisCommitteeB{}% 
188 \else 
189  \def\thesisCommitteeB{#1~#2\textsc{#3},~#4}% 
190 \fi 
191 }
\end{verbatim}
\thesisCommitteeC Set up the \thesisCommitteeC variable.
\begin{verbatim}
192 \def\thesisCommitteeC{}
193 \newcommand{\thesisCommitteeC}[4]{{% 
194 \ifx&#3&% 
195  \def\thesisCommitteeC{}% 
196 \else 
197  \def\thesisCommitteeC{#1~#2\textsc{#3},~#4}% 
198 \fi 
199 }
\end{verbatim}
\thesisCommitteeD Set up the \thesisCommitteeD variable.
\begin{verbatim}
200 \def\thesisCommitteeD{}
201 \newcommand{\thesisCommitteeD}[4]{{% 
202 \ifx&#3&% 
203  \def\thesisCommitteeD{}% 
204 \else 
205  \def\thesisCommitteeD{#1~#2\textsc{#3},~#4}% 
206 \fi 
207 }
\end{verbatim}
\thesisCommitteeE Set up the \thesisCommitteeE variable.
\begin{verbatim}
208 \def\thesisCommitteeE{}
209 \newcommand{\thesisCommitteeE}[4]{{% 
210 \ifx&#3&% 
211  \def\thesisCommitteeE{}% 
212 \else 
213  \def\thesisCommitteeE{#1~#2\textsc{#3},~#4}% 
214 \fi 
215 }
\end{verbatim}
\thesisCommitteeF Set up the \thesisCommitteeF variable.
\begin{verbatim}
216 \def\thesisCommitteeF{}
217 \newcommand{\thesisCommitteeF}[4]{{% 
218 \ifx&#3&% 
219  \def\thesisCommitteeF{}% 
220 \else 
221  \def\thesisCommitteeF{#1~#2\textsc{#3},~#4}% 
222 \fi 
223 }
\end{verbatim}
\thesisNumber Set up the \thesisNumber variable.
\begin{verbatim}
224 \def\thesisNumber{}
225 \newcommand{\thesisNumber}[1]{\def\thesisNumber{#1}}
\end{verbatim}
The cover page is created with the following code
\printcoverpage Print the cover page of the thesis.
\begin{verbatim}
226 \newcommand{\printcoverpage}{{%
\thispagestyle{empty}
\begin{center}
\rule{\linewidth}{0.4pt}
\vspace*{1.2cm}
\textsc{	extbf{\@title}}
\vspace*{1.2cm}
\thesisByLabel
\vspace*{0.4cm}
\thesisLocationLabel\thesisFieldLabel{~}\thethesisField
\vfill
\iftoggle{draft}{~}{
\thesisCommitteeLabel
}\vspace*{0.8cm}
\iftoggle{draft}{~}{\thethesisCommitteeA}
\vspace*{0.8cm}
\iftoggle{draft}{~}{\thethesisCommitteeB}
\vspace*{0.8cm}
\iftoggle{draft}{~}{\thethesisCommitteeC}
\vspace*{0.8cm}
\iftoggle{draft}{~}{\thethesisCommitteeD}

4.9 Front matter

\acknowledgements Set up the \theacknowledgements variable.
\def\theacknowledgements{}
\newcommand{\acknowledgements}[1]{\def\theacknowledgements{#1}}

\abstractEN Set up the \theabstractEN variable.
\def\theabstractEN{}
\newcommand{\abstractEN}[1]{\def\theabstractEN{#1}}

\abstractFR Set up the \theabstractFR variable.
\def\theabstractFR{}
\newcommand{\abstractFR}[1]{\def\theabstractFR{#1}}

\dedication Set up the \thededication variable.
\def\thededication{}
\newcommand{\dedication}[1]{\def\thededication{#1}}

\printfrontmatter The front matter pages are created with the following code
\newcommand{\printfrontmatter}{%}
\iftoggle{draft}{~}{\frontmatter}
\iftoggle{fr}{\chapter*{Remerciements}}{}
\chaptercontentsline{toc}{chapter}{Remerciements}
\}\{\chapter*{Acknowledgements}
\chaptercontentsline{toc}{chapter}{Acknowledgements}
\label{ch:acknowledgements}
\thispagestyle{plain}
\theacknowledgements
\newpage
4.10 Introduction and conclusion starter
The front matter pages are created with the following code:

\begin{verbatim}
\newcommand{\startconclusion}{
  \chapter*{Conclusion}
  \addcontentsline{toc}{chapter}{Conclusion}
  \label{ch:conclusion}
  \markboth{}{Conclusion}
}
\end{verbatim}

4.11 Miscellaneous

\texttt{itemize*} A narrowed version of the \texttt{itemize} environment, implementation here:

\begin{verbatim}
\newenvironment{itemize*}{\vspace{-2mm}\begin{itemize}
  \setlength{\itemsep}{0pt}
  \setlength{\parskip}{0pt}
}{\end{itemize}\vspace{-2mm}}
\end{verbatim}